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Financial System Report Descriptions 
 

Fund Balances by Department, Fund, PI, and User  

• Fund Balances reports provide a list of funds along with the titles and balances of each of those funds. This report 
can be selected to display listings of funds coded to a particular department, by individual fund (This is the Fund 
Summary which summarizes account/cost center balances within that fund), by Principal Investigator and by User 
(User defined funds are set up by selecting funds for a particular user and storing this information on your local 
workstation).  

• The Fund Summary report can be accessed by selecting a specific fund from any of these reports. The Sub-
Object Summary can be accessed by selecting a specific account/cc from the Fund Summary report. 

Account Balances by Department, Account and User 

• Account Balance reports provide a list of Accounts along with the titles of those Accounts. The report can be 
selected to display a list of accounts coded to a particular department, by individual account (This is the Account 
Summary which summarizes balances account/cost center along with the funds which are linked to those 
account/cc) and by User (User defined accounts are set up by selecting accounts for a particular user and storing 
this information on your local workstation). The selection is grouped by the major fund groups, such as, Plant 
Funds, Loan Funds and Current Funds. In addition, the user can select accounts by account categories. The 
options are : Balance Sheet, Fund Balance, Revenue and Expenditure.  

• The Account Summary report can be accessed by selecting an account from the departmental or user list or 
directly by indicating specified account. The Sub-Object Summary report can be accessed by selecting a specific 
fund from the Account Summary report. This detail will be retrieved based on the period criteria selected for the 
Account Summary by Department report (current month, current fiscal year, or other period specified through 
identifying start and end dates).  

Sub-Object Summary 

• The Sub-Object Summary report shows the summary of the selected account/cc/fund detailed by sub and object 
codes.  

• The Detail General Ledger can be accessed by selecting a specific sub-object code to view the detail transactions 
for the sub-object or by selecting ‘Go To Detail General Ledger for Account Transactions’ to view the detail 
transactions for the accounting period specified. This detail will be retrieved based on the period criteria selected 
for the Summary reports (current month, current fiscal year, or other period specified through identifying start and 
end dates).  

Budget to Actual by Department, PI 

• The Budget to Actual report displays balances of expenditure appropriations less actual financial expenditures for 
inception to date funds. The report can be selected to display these summary balances for a particular month by 
Department or PI.  

• The Fund Summary report can be accessed by selecting a specific fund from any of these reports. Other report 
linkages can be made from the Fund Summary report to view more specific detail.  

Expenditures by Fund Source by Organization, Division, Subdivision or Department 

• The Expenditure by Fund Source displays total expenditures within accounts coded to the selected level of the 
organization by Funding Source (General Funds, Federal Funds, Gifts, etc.)vertically and by functional account 
classification (Instruction, Research, etc) horizontally. This information can be selected through a specified date. 

• A list of Funds and balances comprising each fund source can be accessed through selecting a particular fund 
source. Other report linkages can be made from this listing by further selecting the detail for specific funds listed. 

Custom Balances by Department  
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• The Custom Balances by Department Report groups expenditures across a selected department by project or 
cost center. The expenditures are summarized by account/cc/fund for either the project or cost center as of a 
selected date.  

• Detail General Ledger Reports for transactions comprising expenditure totals for selected costs centers or 
projects can be accessed from the Custom Balances Reports.  

Accounts Receivable Report  

• The Accounts Receivable Report provides a list of outstanding accounts receivable balances as of a specified 
period in time. Only receivable balances for contract and grant funds are displayed. This report can be selected 
for a specific department or principal investigator. Further selection can be made for a specific contract and grant 
fund group, and for a specific receivable account group.  

Budget Summary Report by Organization, Division, or Department  

• The Budget Summary Report displays summary totals account/cc/fund of initial budget appropriations (permanent 
budget), reappropriations (balance brought forward from prior year), budgetary adjustments and budget total by 
the selected level of the organization as of the selected date.  

• The Fund Summary report can be accessed by selecting a specific fund from any of these reports. Other report 
linkages can be made from the Fund Summary report to view more specific detail.  

Overdraft Report by fund, by Organization, Division or Department  

• The Overdraft Report by funds, assigned to specific organizations, reflects deficit balances in two distinct ways 
appropriate to the fund type as follows:  

• By Fund: This report provides a listing of fiscal funds, such as Gifts, Endowments, Sales & Services Activities, 
which have deficit fund balance as of the selected date for the specified organizational level. The deficit balance 
reflects total financial balances including any encumbered amounts.  

• By Budget to Actual: This report provides a list of inception funds, or contract and grant funds that have a deficit 
comparing the actual expenditures to the appropriation (budget) of the fund.  

• The Fund Summary report can be accessed by selecting a specific fund from any of these reports. Other report 
linkages can be made from the Fund Summary report to view more specific detail.  

Overdraft Report by Account/Fund  

• The Overdraft Report by Account/Fund reflects deficit balances for funds that are assigned to multiple 
organizations or to the entire campus. These global funds include General Funds, Opportunity Funds and other 
similar funds. Deficit balances relating to these funds, which are linked to organizational accounts, can be 
displayed in the following two manners:  

• By Account/CC/Fund: This report provides a listing of account/cc/funds that have a deficit ledger balance as of a 
selected date for the specified organizational level.  

• By Fund Source: This report aggregates ledger balances of all the global funds by Fund Source (General Funds 
Registration Fees, Gift Funds, Endowment Funds, etc.) at an organizational level and displays the fund sources 
that are in deficit for a selected period.  

Sales and Services Report  

• The Sales and Services Report provides a summary of balances by fund (for the 60000 series and related 
reserve funds) as of a selected date for the specified organizational level in a statement format. This report 
section has three selection areas.  

• By Organization level—This section is divided into four major groups, (1) General Campus-Academic, (2) 
General Campus-Administration, (3) Health Sciences-Compensation Plan and (4) Health Sciences-Other. The 
report lists the funds of a selected organization and by clicking to a fund it provides “Statement of Receipts and 
Expenditures” for the selected fund within an organization. Options to view two years variance and five years 
trend for a given fund is also available.  

• The Fund Summary report can be accessed by selecting a specific fund from these reports.  

• By Major Group Level–This section allows users to select and view reports by four major groups mentioned in 
option above. By clicking on the organization code, the report can display the funds associated with that 
organization and activities of those funds. In this report, the beginning balance (July 1 of the fiscal year selected), 
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outside income, recharge income, expenditures, unexpended balance transfers and fund balance for the selected 
period are displayed.  

• The “Statement of Receipts and Expenditures” and Fund Summary report can be accessed by selecting a specific 
fund from these reports.  

• By Campus—This report displays a comprehensive activity report of Sales and Services funds by organization in 
a summary format. In this report, the beginning balance (July 1 of the fiscal year selected), outside income, 
recharge income, expenditures, unexpended balance transfers and fund balance for the selected period are 
displayed. Users can drill down to view by organization and fund listing the detail of each organization’s activity.  

• The “Statement of Receipts and Expenditures” and Fund Summary report can be accessed by selecting a specific 
fund from these reports.  

Detail General Ledger  

• The Detail General Ledger displays all the transactions posted to the account/cc/fund over a variable accounting 
period, sorted by sub and object codes. Users can retrieve transactions for several months by changing the 'Start 
Period' at the bottom of the report. Detail transactions are available from January 1994 to present.  

• Custom Report–Users have the option to display columns for only selected attributes of the transactions within 
the ledger and to sort the ledger information according to a user defined primary and secondary sort.  

• Users can go to Recharge Activity Ledgers, Open Commitment Subsidiary Ledgers and Payroll Expense 
Distribution Reports from the detail General Ledger.  

Recharge Activity Ledger  

• The Recharge Activity report provides campus service department billing, by transaction, for a given period. 
These are charges resulting from orders placed by the department. The Recharge Activity Report is summarized 
by Sub-Object Code with the total for each Sub-Object Code being reflected in the Detail General Ledger.  

• No linkages are available from this report.  

Reference Control Subsidiary Ledger  

• This report provides the transaction history sorted by reference control for certain balance sheet accounts within 
the Detail General Ledger. These special accounts are put under reference control to monitor detail receivable 
and payable activity. The complete transaction history for that account is retained and reported each time this 
report is generated, until the reference number balances to zero. At zero, the accumulated detail transactions for 
a given account/reference number are displayed for another month before being transferred to the system's 
history files.  

• No linkages are available from this report.  

Source Control Subsidiary Ledger  

• The Source Control Subsidiary Ledger provides the transaction history sorted by source control for certain 
balance sheet accounts within the Detail General Ledger. These special accounts are put under source control to 
monitor detail receivable and payable activity. The complete transaction history for that account is retained and 
reported each time this report is generated until the source number balances to zero. At zero, the accumulated 
detail transactions for a given account/source number are displayed one more month before being transferred to 
the system’s history files.  

• No linkages are available from this report.  

Open Committments Subsidiary Ledger  

• The Open Commitment Subsidiary Ledger provides the accumulated transaction detail that supports the open 
encumbrance and/or memo lien balances for a given account/cc/fund appearing in the Sub-Object Summary 
section of the Detail General Ledger. The transaction detail for a given purchase order, low value order, etc. will 
appear on this report until their balance is zero. At zero, they will appear on the report one more month.  

• No linkages are available from this report.  

Transaction Listing  
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• The Transaction listing displays specified transactions by source system identification or by type entry and 
transaction identification for the selected period. The report displays the location, type entry, account/cc/fund, 
project, sub, object, source, description, reference, and post date for each debit and credit line of the transaction 
selected.  

• NOTE: Please note the following exceptions:  
o For PAC transactions (Type Entry 41-44), users can only view the departmental accounts. The liability 

account transactions are aggregated by date.  
o For Cash deposit in Murphy Hall (Type Entry 33), users can only view the department accounts. The cash 

accounts to record daily collection are aggregated by date also.  
o Hint: Avoid selecting transactions that are campus-wide in nature such as payroll (XXD10), SBAR 

transactions (Type Entry 50, trans. No. XXSBSA and Type Entry 53, trans. No. XXSBSA), 
telecommunications charges (Type Entry 59, trans. No. XXR002), etc..(XX represents fiscal month.)  

• No further linkages are available from this report.  

Gifts Received Undistributed   

• Users can research their portion of the Chancellor's undistributed, but committed, gift fund balances for account 
116030.  

• The report provides transaction information and reference balances for a selected department and time period.  

Campus Organizational Hierarchy  

• The Campus Organizational Hierarchy, By Hierarchy, report provides the reporting structures for the campus 
broken down to organization, division, sub-division, and department levels.  

• The Fund Balances by Department, Account Summary by Department, Departmental Chart of Accounts, and 
Departmental Chart of Funds reports can be accessed by selecting a specific department code from this report.  

• Another option, By Organization, displays the campus hierarchy organized by organization, division, subdivision 
and department. At the end of this report, there is a “Print” option which allows the users to print the selected 
report in the format that is displayed. No further linkages are available from this report.  

Table of Accounts by Department  

• The Department Table of Accounts report provides the list of account/cc numbers that are assigned to the 
selected department.  

• The Account Summary by Account report can be accessed by selecting a specific account number from this 
report.  

Table of Funds by Department  

• The Department Table of Funds report provides the list of fund numbers that are assigned to the selected 
department.  

• The Fund Summary report can be accessed by selecting a specific fund number from this report.  

Sub-Object Listing  

• The Sub-Object Code Listing report provides the list of subs and object codes (active and inactive) that are in the 
Financial System.  

• No linkages are available from this report. 

Recharge ID by Department 

• The Recharge ID by Department table provides a listing of recharge Ids assigned to each specific account/cc/fund 
and sub object code. The table also lists the Fund Title and overhead base and overhead rate information.  

• No linkages are available from this report. 

Service Table Listing 
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• The Service Table Listing provides detail of the service centers by number and description. It displays the journal 
description appearing on the ledger when amounts are charged by the service center and the department sub 
object and object code that will receive a debit when services are charged. Additionally the service centers 
recharge accounts to be credited are displayed for the Account/cc/Fund , Project, Sub, Object and Source within 
the full accounting unit.  

• No linkages are available from this report. 

General Liability Report  

• The general liability report provides a listing by department and account/cc/fund project and sub of applicable 
liability rates including general liability, employment practices, property insurance, and loss prevention, as well as 
an indication of the active date of these rates. Such rates are determined centrally based on loss experience of a 
particular unit.  

• No linkages are available from this report.  

 
Payroll Expense Distribution Report  

• The Payroll Expense Distribution Report displays all payroll expenditures (salaries and benefits) and expense 
transfers posted to the account/cc/fund over a selected accounting period. Users have the option to display 
columns for only selected attributes of the transactions and to sort the information according to a user defined 
primary and secondary sort. Detail transactions are available from February 1995 to the most recently completed 
payroll month. Payroll expense distribution data is created in the Personnel/Payroll System and passed to the 
QDB on a monthly basis. Check the QDB Event Calendar to see the date each month that payroll expense 
distribution data is scheduled to be available in QDB. As soon as the data is available in QDB, it is available for 
reporting in OFSR.  

• Users can access Payroll Expense Distribution Reports from the Payroll folder or from the selection menu at the 
bottom of a Detail General Ledger report.  

 
Award Transactions Processed by EFM  

• The Award Transactions Processed by EFM report provides a list of awards that linked to an account/fund by 
EFM within a specified time period. This report can be selected for a specific department, a fund range, a principal 
investigator, an organization, or an agency. The results of this query can be further specified to include some or 
all of the following information. The award key #, date the linked, the account, the cost center, the budget period, 
the project period, the PI code, the PI name, the department code, the department name, the agency code, the 
agency name, the agency award #, the total current cost, and the overhead rate.  

Contracts and Grants Account Receivable Report  

• The Contracts and Grants Accounts Receivable report provides a list of outstanding accounts receivable balances 
as of a specified period in time. Only receivable balances for contract and grant funds are displayed. This report 
can be selected for a specific department or principal investigator. Further selection can be made for a specific 
contract and grant fund group, and for a specific receivable account group.  

Funds Ending Report  

• The Funds Ending report provides a list of funds that end within a specified time period. This report can be 
selected for a department, a fund range, a principal investigator, an agency, or an organization. The results of this 
query can be further specified to include some or all of the following information. The fund title, the fund begin and 
end date, the PI code, the PI name, the department code, the department name, the agency code, the agency 
name, the agency award#, the operating balance, and the accounts receivable balance.  

Financial Reports Due Report  

• The Financial Reports Due report provides a list of financial reports that are due within a specified time period. 
This report can be selected for a department, a fund range, a principal investigator, an organization, or an agency. 
The results of this query can be further specified to include some or all of the following information. The award key 
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#, the project end date, the PI code, the PI name, the department code, the department name, the agency code, 
the agency name, the agency award #, the report due date, and the report status description.  

Payment Requests Due Report  

• The Payments Due Query report provides a list of invoices that are due within a specified time period. This report 
can be selected for a department, a fund range, a principal investigator, an organization, or an agency. The 
results of this query can be further specified to include some or all of the following information. The award key #, 
the payment type, the payment sub-type, the PI code, the PI name, the department code, the department name, 
the agency code, the agency name, the agency award #, the report due date, and the report status description.  

Financial Reports Completed  

• The Financial Reports Completed report provides a list of financial reports that have been completed within a 
specified time period. This report can be selected for a department, a fund range, a principal investigator, an 
agency, or an origanization. The results of this query can be further specified to include some or all of the 
following information. The fund title, the award key#, the fund begin and end dat, the PI code, the PI name, the 
department code, the department name, the agency code, the agency name, the agency award#, the provision 
number, the report due date, the report submission date, the logon id, and the report status description.  

Payment Requests Completed  

• The Payment Requests Completed report provides a list of payment requests that have been completed within a 
specified time period. This report can be selected for a department, a fund range, a principal investigator, an 
agency, or an organization. The results of this query can be further specified to include some or all of the following 
information. The fund title, the award key#, the fund begin and end date, the payment type and subtype, the PI 
code, the PI name, the department code, the department name, the agency code, the agency name, the agency 
award#, the provision number, the report due date, the report submission date, the logon id, and the report status 
description.  

 

Printing Options 

A new print option has been developed for most of the financial reports. From various Report Parameter panels, under 
"Choose an Output Type" select the "Print Friendly Report" option. Using this option, when a report is printed, the 
column headings will be repeated on every page. This feature currently works with the Internet Explorer web browser 
only. NOTE: For better results, please select the Landscape Orientation.  

 

Excel Download 

This feature lets you download reports to a local file in the Excel format so that users have available the many worksheet 
features of Excel to group and further analyze financial data available through the OFSR. Remember that any reports 
prepared from downloaded information must be reconcilable back to source information in accordance with Campus 
Financial Policies. Simply select the "Excel Download" option under "Choose an Output Type". You can resize columns, 
add labels, modify values, and print out the report.  

Special Instructions for users using Windows with Internet Explorer 

By default, Internet Explorer hosts an Excel worksheet for viewing instead of opening Microsoft Excel. Some 
Excel features work only if the Excel worksheet is viewed in Microsoft Excel. 

To work around this behavior, there are three options. 

Copy the Excel worksheet to Microsoft Excel. 
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After the worksheet is displayed in Internet Explorer, use the following steps: 

1. On the Edit menu, click Select All (or press Ctrl-A) to highlight the worksheet.  
2. On the Edit menu, click Copy (or press Ctrl-C) to copy the worksheet.  
3. Start Microsoft Excel.  
4. Within Excel, on the Edit menu, click Paste (or press Ctrl-V) to paste the worksheet.  

- OR - 
Save the Excel worksheet and open it in Microsoft Excel. 

After the worksheet is displayed in Internet Explorer, use the following steps: 

5. On the File menu, click Save as.  
6. In the Save as type drop-down list, select Microsoft Excel Workbook.  
7. Specify a directory and filename for the Excel workbook and click Save.  
8. Open the Excel workbook from Microsoft Excel.  

- OR - 
Configure Internet Explorer to open Microsoft Excel.  

This option modifies your system to always open a new Excel window when downloading spreadsheets. 
To do this, use the following steps: 

9. Double-click My Computer.  
10. On the View menu, click Folder Options.  
11. Click the File Types tab.  
12. In the Registered file types list, select Microsoft Excel Worksheet, and then click Edit ( or Advanced if 

using Windows XP).  
13. In the Edit File Type dialog box, click to clear the Browse in same window check box.  
14. Click OK.  

 

Future Enhancements 

Corporate Financial Services and AIS are continuing efforts to expand the suite of available reports that provide centrally 
supported official book of record information to the campus. Any suggestions for improvements to the existing system or 
additional reporting needs should be made through use of the feedback button within the On-Line Financial Reporting 
System. Future reports will be announced as they become available  
 

Reference Website:  https://ofsr.it.ucla.edu/FSReports/desc.asp  


